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1 General 

1.1 Information  

This manual describes the coatmaster 3D and provides all information required for its safe operation 
and to maintain it in good working order.  

Read this manual carefully before installing and running your system and note the safety precautions 
in chapter 2 in particular. Store the manual in the immediate vicinity of the instrument, so that it can 
be consulted at any time.  
 
Figures in this manual serve the general understanding and might deviate from the actual product 
design. 

1.2 About this manual 

The User Manual contains instructions on proper installation, use of the coatmaster, safety infor-
mation, and user maintenance and trouble shooting. More detailed information on network and com-
munication setup, calibration, applications and external remote control are available in the User Man-
ual. 

Paragraphs starting with NOTE contain helpful information for working with the device/software or its 
supplementaries. NOTE’s are not related to any kind of hazard or damage (see following example).  

NOTE  
Useful tips for the easy operation of the instrument/software. 
 

1.3 Liability limitation 

The device is designed and built in accordance with current state-of-the-art technology. Nevertheless, 
risks to users, property, and the environment can arise when the device is used carelessly or improp-
erly.  

coatmasster AG has determined the following residual dangers emanating from the device:  
• The User Manual is not considered. 
• The device is not operated according to its proper use.  
• The device is operated by insufficiently trained personnel.  
• Unauthorized modification of the device. 
• Use of unlisted spare parts 

 
Appropriate warnings in this manual serve to make the user alert to these residual dangers. 
 
Due to special designs, additional options are latest technical modifications, the actual scope of deliv-
ery might deviate from the descriptions and illustrations herein. 
 
The obligations agreed upon in the delivery contract, the General Terms and Conditions as well as 
the delivery conditions of the manufacturer and the legal provisions in effect at the time of contract 
closure shall be applicable. 
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1.4 Copyright 

No technical modifications may be made to the device without the prior written agreement of coat-
master AG. Unauthorized modifications may affect the system safety or result in accidents.  
 
This manual is copyright. Information from it may not be reproduced, distributed, or used for com-
petitive purposes, nor made available to third parties. The manufacture of any component with the 
aid of this manual without prior written agreement is also prohibited.  
 

1.5 Warranty conditions 

The warranty conditions are part of the General Terms and Conditions of the manufacturer. 
 
Any system modification and modification of the embedded PC as e.g. 

• Installation of further software 
• Software updates 

can affect or damage the coatmaster and are therefore prohibited. 
coatmaster AG assumes no liability for data loss on the embedded PC. It is suggested to regularly 
backup the data on the embedded PC (application and measurement data). 

1.6 Scope of delivery 

Version 2 with lamps: 
• 1 coatmaster 3D optical head 
• 1 CM flash generator unit (19“-rack insert, 3 height units) 
• 1 CM control unit (19“-rack insert, 3 height units) 
• 2 lamps mountend on aluminum support 
• 1 USB stick with the coatmaster 3D User Interface 
• 1 set of cables (up to 6 Ethernet cables max 25m each, 3 90-264V C13/C14, 1 sync cable and 

2 Harting HAN16B) 
• 1 User Manual 

 
Version 4 with lamps: 

• 1 coatmaster 3D optical head 
• 2 CM flash generator unit (19“-rack insert, 3 height units) 
• 1 CM control unit (19“-rack insert, 3 height units) 
• 4 lamps mountend on aluminum support 
• 1 USB stick with the coatmaster 3D User Interface 
• 1 set of cables (up to 8 Ethernet cables max 25m each, 3 90-264V C13/C14, 1 90-264V C20, 1 

sync cable and 4 Harting HAN16B) 
• 1 User Manual 
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Version 6 with lamps: 
• 1 coatmaster 3D optical head 
• 3 CM flash generator unit (19“-rack insert, 3 height units) 
• 1 CM control unit (19“-rack insert, 3 height units) 
• 6 lamps mountend on aluminum support 
• 1 USB stick with the coatmaster 3D User Interface 
• 1 set of cables (up to 10 Ethernet cables max 25m each, 4 90-264V C13/C14, 1 90-264V C20, 

1 sync cable and 6 Harting HAN16B) 
• 1 User Manual 

 
 
Version 8 with lamps: 

• 1 coatmaster 3D optical head 
• 4 CM flash generator unit (19“-rack insert, 3 height units) 
• 1 CM control unit (19“-rack insert, 3 height units) 
• 8 lamps mountend on aluminum support 
• 1 USB stick with the coatmaster 3D User Interface 
• 1 set of cables (up to 12 Ethernet cables max 25m each, 5 90-264V C13/C14, 1 230V/400V 

CEE16, 1 sync cable and 8 Harting HAN16B) 
• 1 User Manual 
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2 Safety 

This section gives an overview of all relevant safety aspects for an optimal personal protection as 
well as for a save and undisturbed operation. 

2.1 Responsibility of the operator 

The operator is responsible for training his/her personnel.  

The operator shall inform the manufacturer without delay of any safety-related incidents which might 
occur during operation of the device or its accessories.  

Issues can be reported to the e-mail address: info@coatmaster.com 
Legal regulations, such as local, state and federal laws applying to the device or its accessories must 
be strictly followed.  

2.2 User qualification 

Before the use of the coatmaster the user manual must be read and understood.  
The device may only be used by persons who on account of training or professional experience have 
an overview of the dangers which may arise when operating the device. 

2.3 Proper use 

The coatmaster is exclusively designed for measuring thicknesses of coatings. It can be used for the 
following coatings: 

• powder coatings on metallic substrates 
• adhesive coatings on metallic substrates 
• polymer coatings on metallic substrates 
• wet paint on metallic substrates 
• wet paint (wet-state) on non-metallic substrates 
• thermal spray coatings. 

The device must only be operated and cleaned by trained personnel. The proper use also includes 
adherence to this manual. The service intervals must be strictly followed. 

2.4 Improper use 

Use not mentioned above or use that does not comply with the technical specifications is considered 
improper use. The operator bears the sole risk for any damages caused by such improper use. The 
following uses are forbidden:  

• Use of the coatmaster in environments, where liquids can enter the housing. 
• Introduction of any objects into the coatmaster 3D. 
• Opening the coatmaster’s housing. Exception: Cleaning or changing the filter pad (see chap-

ter 7). This is also valid when the coatmaster is not connected to the mains. When the coat-
masters is opened, the warranty is void and the manufacturer disclaims all liability. 

• If liquid leaks from the coatmaster, unplug the device immediately and contact technical sup-
port.  
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Technical support for the coatmaster +41 (0) 52 212 02 77, info@coatmaster.com  
 

2.5 Use in the presence of flame dectectors. 

Tests were extensively carried out to assess a possible triggering of a flame detection system in the 
vicinity of a coatmaster 3D in operation mode.  

• The alarm of the flame detector from the brand STS (models FL-8.64 and FL.9) is not trig-
gered for UV+IR setting in any combination of coatmaster type and flame detector type. The 
alarm is triggered only for IR setting.  The certification page by the company STS Brand-
schutzsysteme GmbH (Germany) can be found in chapter 11.1 on page 62. 

• The alarm of the flame detector from the mark Walther-Total (model UV-03) is not triggered 
by any combination of coatmaster type and settings. The certification page by the company 
Tyco Integrated Fire & Security AG (Switzerland) can be found in chapter 13.2 on page 63. 

The full testing reports are available upon request. 

2.6 Safety warnings and signals used in this manual 

2.6.1 Description of the safety warnings 

DANGER, WARNING, CAUTION and NOTICE are standardized signal words for identifying levels of 
hazard seriousness of risks related to personal injury and property damage. All signal words, which 
are related to personal injury are accompanied by the general safety sign.  

For your safety it is important to read and fully understand the below table with the different signal 
words and their definitions! 

Sign Signal word Definition Risk level 
 

 

DANGER Indicates a hazardous situation which, if not 
avoided, will result in death or serious injury.  
 

���� 

 

 

WARNING Indicates a hazardous situation which, if not 
avoided, could result in death or serious injury.  
 

��� 

 

 

CAUTION Indicates a hazardous situation which, if not 
avoided, may result in minor or moderate injury.  
 

�� 

 NOTICE Indicates possible property damage, but no prac-
tices related to personal injury.  

 

 
Supplementary safety information symbols may be placed in a rectangular panel on the left to the 
signal word and the supplementary text (see below example). 

mailto:info@coatmaster.com
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DANGER 

Supplementary text, describing the hazard/risk (e.g. explosion). Result of the hazard 
if not avoided (e.g. death). 
1. List of measures to avoid the herein described hazard or harzardous situation. 

 

2.6.2 Used symbols 

The below reference list incorporates all safety information symbols used in this manual or on the 
device and their meaning. 

 
Symbol Meaning 

 

General hazard 

 

Device damage 

 

Electrical hazard 

 

2.7 Product safety 

The device is designed and built in accordance with current state-of-the-art. Nevertheless, risks to us-
ers, property, and the environment can arise when the device is used carelessly or improperly.  

coatmasster AG has determined the following residual dangers emanating from the device:  
• The device is operated by insufficiently trained personnel.  
• The device is not operated according to its proper use. 

 
Appropriate warnings in this manual serve to make the user alert to these residual dangers. 
 
This device was tested in compliance with the safety requirements for electrical equipment for meas-
urement, control and laboratory use IEC 61010-1 (2010) and the Low Voltage Directive 2014/35/EU.  
 
The device satisfies the EMC requirements for electrical equipment for measurement, control and 
laboratory use of the international standard IEC 61326-1 (2012).  This class equipment is intended for 
use in an industrial environment. And as such, there may be potential difficulties in ensuring electro-
magnetic compatibility in other environments, due to conducted as well as radiated disturbances 
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To ensure photobiological safety the device should be operated in accordance with the 
guidelines for the safe use of intense pulsed light source equipment on humans IEC 62471-3 
(2015). 
 

2.7.1 General hazards 

The following safety messages show hazards of general kind which may occur when handling the de-
vice. The user shall observe all listed counter measures in order to achieve and maintain the lowest 
possible level of hazard.  
Additional warning messages can be found whenever actions and situations described in this manual 
are related to situational hazards. 

 

 

 
WARNING 

Explosive Environment 
Working in potentially explosive rooms and environments is prohibited because small 
sparks develop upon triggering the flash.  
 
◊ Never work in potentially explosive environments. 
◊ Do not work near flammable material. 
◊ Do not store flammable material in direct vicinity of flash generators and flash lamps 
to avoid fire hazards. 
 

 

  
 

 

 
CAUTION 

Integrated light source. 
The coatmaster® contains a flash lamp which falls under the risk group 3 according to 
the photobiological safety of IEC62471:2015. The coatmaster® does not emit harmful 
UV radiation. 
 
Hazardous optical radiation may possibly be emitted from this product in case of di-
rect and narrow eye contact. Visual impairment or eye injury may result. 
 
◊ Never look directly into the light source. 
◊ Never point the device towards a person in the near vicinity. 
◊ For the use of the coatmaster® in an operator process environment, we recommend 
setting up any protective means (blackened metal sheet) to limit any risks of direct ex-
posure to the flash light. 
◊ In case of damage to skin or eyes caused by intensive optical radiation consult a phy-
sician immediately.  
◊ Use the coatmaster® in a well-lit environment. 
 

 

  
 

 

 
CAUTION 
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Ozone Formation 
If the room is not enough ventilated, the ozone can lead to respiratory disease.  
 
◊ Closed rooms must be ventilated frequently to prevent excessive ozone formation 
which can result from the use of strong flash units.  
 

 

 

2.7.2 Integrated safety elements 

An overcurrent protector of 10A or 16A (depending on the version) for each phase is installed inside 
the control unit.  
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3 coatmaster Hardware Interfaces 

3.1 coatmaster 3D 

 
Figure 1. 3D CAD illustration of the coatmaster 3D optical head 

 
Figure 2. Frontal (upper) and top (lower) views of the coatmaster 3D optical head 
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Figure 3 coatmaster 3D generator unit rack 
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Figure 4 coatmaster 3D control unit for different versions (2, 4, 6 and 8 lamps) 
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4 System Installation 

NOTE 
Inspect the device for damages during unpacking. Accept damaged packages only under reservation 
of possible damage. Write this reservartion on the delivery note. Immediately inform the carrier and 
the sender and do not unpack the damaged package until notification of the sender. 

Keep the original packaging material for future transportation. 

4.1 Hardware installation 

Before the use of the coatmaster the user manual must be read and understood.  
The installation of the device must be done only by an integrator (partner of the customer or directly 
from coatmaster AG). The device may only be used by persons who on account of training or profes-
sional experience have an overview of the dangers which may arise when operating the device. 
 

• The racks have to be installed in a hermetic climatizer electrical cabinet so their will be 
properly cooled.  

• The head has to be installed on a moving axis or fixed on a rail in the way to have a good im-
age of the samples. See chapter 5.6.1. 

• Do not place any objects on or under the device. 
• Connect the device with the mains by means of the mains cable contained in the scope of 

delivery. 
 

 

 

 
WARNING 

Risk of burns by electric current. Serious injuries or death can result. 

Check for proper grounding before use. Replace defective cabling instantly.  
 

 

 

 
CAUTION 

Integrated light source. 
The coatmaster® contains a flash lamp which falls under the risk group 3 according to 
the photobiological safety of IEC62471:2015. The coatmaster® does not emit harmful 
UV radiation. 
 
Hazardous optical radiation may possibly be emitted from this product in case of di-
rect and narrow eye contact. Visual impairment or eye injury may result. 
 
◊ Never look directly into the light source. 
◊ Never point the device towards a person in the near vicinity. 
◊ For the use of the coatmaster® in an operator process environment, we recommend 
setting up any protective means (blackened metal sheet) to limit any risks of direct ex-
posure to the flash light. 
◊ Use the coatmaster® in a well-lit environment. 
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NOTE  
To cut the power in case of an emergency by unplugging, the devices or any other items must not 
block the mains plug! 

 

 

 
NOTICE 

Risk of false alarm of flame detectors. Incompatible flame detectors might be triggered 
wrongly by means of the coatmaster’s light impulse.  

For rooms where the coatmaster 3D is operated, use compatible fire detectors with dual 
UV/IR sensors (e.g. from the company STS Brandschutzsysteme GmbH or Walther-Total (see 
section 2.5 on page 6). 

 

 
 

 

 
NOTICE 

Risk of device error by fingerprints on the camera lense. Contaminations on the camera lense 
might lead to measurment errors. 

Never touch the lense directly. Clean the lens and measurement window as described in chap-
ter 7.2. 

 

 
 

 

 
NOTICE 

Risk of overheating. Too little or too hot air flow within the lamps can lead to overheating. 

Always check the cooling system of the lamps if it works correctly.  
 

 

4.2 Software requirements 

The coatmaster 3D can be operated via two different software environments: 
 
coatmaster 3D Operating System: Starting measurements, creating applications, exporting measure-
ment data, display measurement values and statistics. The creation of applications and the export of 
measurement data can only be done with the coatmaster 3D Operating System. The software must 
be installed on a Windows-PC.  

System requirements: 

• Operating system: Windows 10, 32 or 64bit 
• Processor: 2.4 GHz 
• Working memory: 4 GB 
• Available harddisk memory: 300 MB 
• Display resolution: 1024 x 768 
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Remote control: Measure over the TCP/IP-interface. This interface is used to trigger measurements 
and to transfer measurement data. Examples: PLC systems like Siemens S7 or Beckhoff TwinCAT. 

Before you can measure through the remote control, a corresponding application must be created 
with the coatmaster 3D Operationg System. This is described in chapter.5.5 

4.3 Interface to connect with control computer 

To be able to operate the coatmaster 3D, the computer must be connected with an Ethernet cable to 
the coatmaster 3D. 
 

4.4 Network and administrator settings 

Make sure that the coatmaster is correctly installed as described in chapter 4.1 Hardware installation 
and switch it on. Proceed as follows to configure network and install software: 

1. Configure the coatmaster network access as described in chapter 4.4.1. 
2. Install the coatmaster Operating System at least on one Windows-computer as described in 

chapter 4.4.2. The coatmaster Operating System is needed to create coatmaster applications. 

4.4.1 Configuring coatmaster network 

Make sure the coatmaster and the operating computer are connected with an Ethernet cable. The IP 
address of the coatmaster is noted in the coatmaster Maintenace Manual, which is part of the scope 
of delivery. If you want to change the network configuration (IP address and gateway), proceed as 
follows: 
Enter the device menu trough File -> Devices. The device settings windows will appear as shown in 
Figure 5. When you click on CHANGE IP ADDRESS a new window will appear, where is possible to set 
a new IP addreas and gateway.  
 

 
Figure 5 Device settings 
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After having changed the network settings, restart the coatmaster (switch off the main switch, wait 
for 10 seconds and switch on the device again).  
 

4.4.2 Installing coatmaster Desktop Software 

1. Copy the cm3dGui_V2_013 (or the latest version) compressed folder from the USB stick to 
the laptop and unzip it.  

2. The extracted archive contains the folder release which contains the executive file 
“cm3dguiQml”. Create a link from “cm3dguiQml” and move it to the desktop so that it is eas-
ily accessible. 

3. Switch on the cm3D rack (front button) and the ventilation, if present (wait one minut in or-
der to startup all the components of the coatmaster). 

4. Start the coatmaster Operating System 19 software by double-click on the icon. 
5. On the main window of the GUI. Select File and then Device (see Figure 7). 
6. In the dialog window select the coatmaster to connect to (see Figure 8).  
7. In case the coatmaster does not appear in the list select the add new device button and enter 

the IP address of the coatmaster 3D (here:  192.168.10.155) 
8. In the field Connect to device enter the coatmaster IP address (see chapter 4.4.1). 
9. Connect the PC and the coatmaster via an ethernet cable. Click connect to make sure that 

the connection can be established. If the connection fails, please verify the IP address, the 
Ethernet connectivity and the software version.  

 Please pay attention that the laptop-client and the cm3D must be in the same subnet 
 
 

 
Figure 6. Open the connecting window 
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Figure 7. Connecting the cm3d and the client SW 
 

4.4.3 Define administrator settings within the Operating System 

In the window settings under the tab options is possible, by the software administrator, to disable 
the editing and deleting of the application for users.  

 
Figure 8. Administrator settings in coatmaster software 
 
To change the setting, click on the empty square of lock the user interdace. A Login dialog opens. Ad-
ministrator password: admino041. Click OK. The left field Applications and its options disappear. By 
activating or deactivating the check box you can now enable or disable the editing and deleting of 
applications (always with the password request). The function refers to the creation of a new applica-
tion, to deleting, copying, renaming and editing an existing one. 
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4.4.4 Dark mode selection  

If on the working station, where the coatmaster 3D computer is positioned, there is too much light, is 
possible to change the color of the operating system as follow.  
Clicking on Options -> Settings in the main window of the coatmaster 3D GUI a window with multiple 
options will appear.  
Select dark mode (see Figure 8)and all the windows will change from white to black color.  
To return to light modus, you unselect dark mode and the windows will return in white factory set-
tings.  

 
Figure 9 Dark mode 
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5 Measuring coating thickness with coatmaster 

The technology used for all coatmaster AG’s products is following the requirements of the norm DIN 
EN ISO 2808. The coatmaster technology belongs to the Photothermal method as described by the 
norm. 
 
The following subsectiuons guide you through the working principle and best practises to optimally 
operate your coatmaster. 
 

5.1. Measuring principle 

The coatmaster operates according to the principle of thermal testing of coatings. Thereby the coat-
ing surface is warmed by means of a light impulse. After the initial warm-up by a few degrees, the 
surface cools down as the heat diffuses in deeper areas of the coating and the substrate. The evolu-
tion on the surface depends on the physical properties of the coating. The thinner the coating is 
(given that it has a lower thermal conductivity than the substrate), the faster the surface tempera-
ture decreases.  
 

 
Figure 10 Schematic diagram of Thermal Testing of Coatings 
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5.2. coatmaster application for rough surfaces 

For rough surfaces, we recommend to use a reference method such as weighing, or multiple mi-
croscopic cross-section measurements to even out the large variation in thickness results by cross-
section analysis. With a contacting reference method (e.g. electro-magnetic or micrometer 
probes) the surface roughness drastically reduces the repeatability of thickness measurements. A 
large coatmaster measurement spot will reduce dependency of inaccurate part placement. 
To find the best spot size for your application, you can choose the coatmaster with different types 
of camera optics: namely 18°x14°;20mm, 29°x22°;13mm, 53°x28°;8mm, 80°x54°;6mm. For a given 
measuring distance, the wider the selected focal length, the larger the measurement area size. As 
an illustration, we give in Figure 14, the curves showing the area size as a function of the measure-
ment distance for different optics.  
 

  
Figure 11 : coatmaster 3D measuring area as a function of the measurement distance for different optics of the front cam-
era. 
 
 
The working distance can be selected according to the following rules: 

• The camera must be positioned as close as possible to the sample in order to get the best sig-
nal 

• Once you know the height end width of the measuring area, you can select in the Table 1 be-
low the best optics according to the first rule 
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Measuring 
distance 
from the 

object [m] 

Optics type: 18° x 14°; 
f=20mm 

Optics type: 29° x 22°; 
f=13mm 

Optics type: 53° x 38°; 
f=8mm 

Optics type: 80° x 54°; 
f=6mm 

Height 
[m] 

Width 
[m] 

Area 
[m2] 

Height 
[m] 

Width 
[m] 

Area 
[m2] 

Height 
[m] 

Width 
[m] 

Area 
[m2] 

Height 
[m] 

Width 
[m] 

Area 
[m2] 

0.10       0.04 0.06 0.00 0.08 0.1 0.01 0.11 0.17 0.02 

0.25 0.06 0.08 0.00 0.1 0.14 0.01 0.18 0.25 0.05 0.26 0.41 0.11 

0.50 0.13 0.16 0.02 0.2 0.27 0.05 0.35 0.5 0.18 0.51 0.82 0.42 

0.75 0.19 0.24 0.05 0.3 0.4 0.12 0.52 0.75 0.39 0.77 1.24 0.95 

1.00 0.25 0.33 0.08 0.4 0.53 0.21 0.7 1 0.70 1.03 1.66 1.71 

1.25 0.31 0.41 0.13 0.5 0.66 0.33 0.87 1.24 1.08 1.28 2.08 2.66 

1.50 0.37 0.49 0.18 0.6 0.79 0.47 1.04 1.49 1.55 1.54 2.5 3.85 

1.75 0.43 0.57 0.25 0.7 0.93 0.65 1.21 1.74 2.11 1.79 2.92 5.23 

2.00 0.49 0.65 0.32 0.8 1.06 0.85 1.39 1.98 2.75 2.05 3.34 6.85 

2.25 0.55 0.73 0.40 0.9 1.19 1.07 1.56 2.23 3.48 2.3 3.76 8.65 

2.50 0.62 0.81 0.50 1 1.32 1.32 1.73 2.48 4.29 2.56 4.17 10.68 

2.75 0.68 0.89 0.61 1.09 1.45 1.58 1.9 2.72 5.17 2.81 4.59 12.90 

3.00 0.74 0.97 0.72 1.19 1.58 1.88 2.07 2.97 6.15 3.07 5 15.35 

3.25 0.8 1.06 0.85 1.29 1.71 2.21 2.25 3.22 7.25 3.32 5.42 17.99 

3.50 0.86 1.14 0.98 1.39 1.84 2.56 2.42 3.46 8.37 3.58 5.84 20.91 

3.75 0.92 1.22 1.12 1.49 1.97 2.94 2.59 3.71 9.61 3.83 6.25 23.94 

4.00 0.98 1.3 1.27 1.59 2.11 3.35 2.76 3.96 10.93 4.09 6.67 27.28 
Table 1 Measurement area for different camera optics 
 

5.3. Best practices 

We give in this section some hints on how to optimally use your coatmaster, for in-line measure-
ments. 
 

5.3.1. Measuring on moving parts (optional) 

It is possible to measure coating thicknesses on moving parts for in-line coating application.  
The measuring optic will be mounted on a short moving axis, which will follow the moving parts in-
line for the period of the measure itself.  
In order to be conduct in-line measurements, the line must run at a maximum of 7 m/min (value 
valid for 2020, contact coatmaster AG to check if there is developed a faster version).  
The coatmaster lamps heats up a wide area about 3 meters diameter (the exact value depends on 
lamps positioning).  
 
A manual with examples and descriptions is available under request. For more info contact your sale 
contact at coatmaster AG.  
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Figure 13 IR signatures for different coating thicknesses for powder coating 

5.3.2. Setting the measuring time 

The time duration during which a coated sample thermally reacts to an excitation depends among 
others on the thickness of the coating: for a given set material (coating and substrate) the thicker the 
coating, the longer the time IR signature is (see Figure 11 and  Figure 12). The measuring time should 
be optimally chosen in order to cover the entire length of the IR signature but not too long in order 
to reduce the influence of the low value signal which does not bring any information in terms of ac-
curacy and affects the precision of the measurement. In the case illustrated in Figure 11, a measuring 
time of 20-25 ms is good enough. For powder coating is reccomanded a measuring time between 200 
and 300 ms, as shown in the Figure 12. For thicker powder coating, the measuring time, might be in-
creased. 

  
Figure 12: IR signatures for different coating thickness for a given set of materials (coating and substrate) 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.3.3. Flash generator statu 

At any time is possible to check the status of the flash generators. If a lamp does not flash and it’s a 
generator problem, it will be showed in this window. To open it click on File -> Flash unit and the fol-
lowing window will appear. If any of the generators shows an error, contact coatmaster AG.  

1ms 2ms 10ms 20ms 

102µm 

58µm 

1ms 2ms 10ms 20ms 0,1s 
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Figure 14 Flash generator error window 

5.3.4. Setting the energy level and lamp lifetime 

The coatmaster can measure in 7 steps with energy settings from 750J to 3000J. The quality of the 
measured temperature curve depends on the energy setting, the measuring distance, the measuring 
angle and the color of the coating.  
The higher the energy, the higher the heating of the sample and as such the better the SNR and the 
precision of the measurement (see chapter 5.6.2 on how select the lamp energy).  On the other 
hand, the life duration of the lamp also depends on the energy level which is in use (see Table 1). As 
such it is recommended to select the minimum energy, without compromising on the lamp lifetime. 
Be careful that the energy must be set before the first reference measurement when you are creat-
ing an application. To change the setting for a coatmaster application with existing reference meas-
urements, all reference measurements must be deleted and must be retaken! 
 
 

Energy (Joules) Lamp Lifetime (number of measurements) 
750  

1125  
1500  
1875  
2250  
2625  
3000 250’000 

 
Table 2: life duration of the flash lamps 
 
The lamp lifetime is about 250’000 measurements. It means e.g. for a measuring cycle of 8s, the lamp 
will have to be replaced every 21 days.  
250’000 measurements / 8s = 31’250 minutes = 520,83h = 21,7 days. 
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5.3.5. NUC 

In the ir live view tab, you can apply a Non-Unifirm Compensation (NUC) filtering to get better infra-
red image quality, especially if one changes the operational temperature range. (see Figure 15).  

 
Figure 15 NUC funtionality 
 
 

5.4. coatmaster applications for coatings before curing 

The coatmaster can be used to measure coating thickness before curing without touching (and thus 
destroying) the coating. This allows to use the coatmaster for process control and to establish pro-
cess statistics.  For this purpose, the coatmaster can be configured to predict cured coating thickness 
from measurements before curing.  
 
Special considerations must be made for measuring before curing, depending on the type of coating 
(powder or wet), as described in chapters 5.4.1 and 5.4.2. 

5.4.1. Measuring powder coatings before curing 

Powder coatings not only give surfaces a high-quality appearance but also functional properties. The 
most important functional properties include protection against corrosion and electrical insulation. 
However, a powder coating can only fulfill these properties if the thickness of the coating does not 
exceed or fall below a given tolerance window. 
 
Powder coatings are not even in thickness, rather the surface is wavy and the thickness changes 
within few millimeters’ distances. This waviness is influenced by different parameters such as pre-
treatment, type and waviness of the substrate, paint type (e.g. grain size distribution and chemical 
composition). The waviness is also still visible after curing, and depends on curing conditions (tem-
perature distribution, curing times). Figure 15 shows a typical 2x2 mm extract of a powder coating 
surface with thickness differences of 15µm. 
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Figure 16: Waviness of powder coating after curing 
 
 
The measurement principle of the coatmaster can compensate for this waviness by an optical aver-
aging. This allows reliable determination of the coating thickness. 
 
Depending on the geometry of the object to be coated, keeping the tolerance window can be a tech-
nical challenge. During the application, powder particles are significantly influenced by three physical 
effects, namely electrostatics, aerodynamics and gravity. The effects of electrostatic forces and grav-
ity can be imagined at ease, while physics gets complicated in interaction with aerodynamics. The 
coating of sharp edges can lead to unexpected effects. 
 
Sharp edges are considered to be weak spots for corrosion protection and electrical insulation even 
after coating. The weak points arise because the necessary coating thickness cannot be built upon 
sharp edges. Sharp edges are typically created by trimming sheet metal or laser cutting. An effective 
countermeasure is the rounding of sharp edges by blasting or grinding. One effect that can lead to 
the thickness falling below the specified minimum is the shrinkage of coatings at edges. Here, the 
coating material flows away from the edge-driven by the surface tension after softening at elevated 
temperatures. In the region of the curvature, the coating thickness thus decreases, and a greasy edge 
is formed in the area around it. 
 
New investigations show that the layer thickness on the edge before baking can be lower than gener-
ally assumed. In an experiment, two profiles with two different radii of curvature (5mm and 500µm) 
are powder coated at the same time (RAL 2008, smooth finish). The powder gun is located at 50 cm 
from the object, at a high voltage of 50kV and a conveying air of xx l/min. After powder coating, the 
layer thickness distribution is measured with a coatmaster 3D before baking (see Figure 39). The 
measured image section is 25 mm x 25 mm, with a spatial resolution of 100µm. 
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Figure 17 Coating thickness distrubution on profiles with different radii of curvature recorded with a coatmaster 3D at-
line 
 

5.4.2. Measuring wet coatings before curing/drying 

The wet coating thickness is usually measured to determine the thickness of the coating after curing. 
This only produces repeatable results if the ratio of solvent to solids remains constant. However, in a 
wet coating the solvent evaporates, so that the ratio changes with time. Therefore, the coatmaster 
reference measurements should be made in the same state of the coating as when the coatmaster is 
to be used to make measurements. 

5.4.3. Procedure to make coatmaster applications for measuring coating thickness before curing 

1. Produce reference parts to be used for the coatmaster application. These parts should cover 
the range to be measured by the coatmaster. This range can for example be the tolerance 
range of the coating process. We suggest to make two parts at minimum and two parts at 
maximum thickness of the measurement range. 

2. Make a new application on the coatmaster as described in chapter 5.5 Making new coatmaster 
applications . Give a name to this application that indicates that this application is to be used 
for measurement in the process (e.g. “wet state”). Fit each reference part in the filed of view 
of the camera and take a reference measurement with the coatmaster 3D. Press Save after 
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taking the reference measurement without entering the reference values. Make sure that the 
positions of the reference measurements can be found again, e.g. by marking without destroy-
ing the coating at the measurement positions. This gives a total of eight reference measure-
ments for the coatmaster applications. Depending on the precision of the method to measure 
the reference value, the number of required measurements might change. 

3. Finish curing the coating on the reference parts. 
4. Measure the coating thickness on the reference parts in the marked positions with a reference 

method (e.g. microscopic cross-section analysis). Enter the coating thickness in the “wet” coat-
master applications. 

5. If possible and required, make a second new application on the coatmaster, adding reference 
measurement on the cured reference parts at the same positions. If the parts have been cut 
for microscopic analysis, make the reference measurements close to the original position. Give 
a name to this application that indicates that this application is to be used on cured parts only 
(e.g. “cured state”). This application is only required for periodic verification of proper func-
tioning of the coatmaster on the reference parts. 

6. Repeat the measurement on the reference parts with the “cured” coatmaster application at 
the marked positions. Note down the coating thickness values from the coatmaster for each 
position. These values should be close but might not be the exact same as the values from the 
reference method. The coatmaster should always produce these same values when repeating 
the measurements on the reference parts. 

 

5.5. Making new coatmaster applications  

Coating processes are specified by an upper and lower limit value for the coating thickness (tolerance 
window). For calibration by reference measurements, we recommend to use at least one sample 
with a coating at the lower boundary and one sample at the upper boundary of the tolerance win-
dow. On these reference samples, carry out one measurement for each with the coatmaster and 
mark the measurement points, so that the coating thickness can be measured with a reference 
method at the same measurement points at a later stage. 
For best results, we recommend to use the same materials and parts for calibration as used later for 
measurement. However, the coatmaster tolerates certain deviations between calibration and meas-
urement as follows: 

1. Calibration on metal substrate and measurement on substrate with slightly different alloy 
combinations (e.g. different steel types).  

2. A certain amount of temperature variation is acceptable, depending on coating and substrate 
material. 

The following factors influence the coatmaster measurement, so that there should be the same con-
ditions during calibration and measurement: 

1. Surface roughness: If the measurement is carried out on rough surfaces, the calibration 
should be done on rough surfaces as well. 
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2. Substrate material: In case the same coating is measured on different substrate materials 
(e.g. on metal or plastic or on aluminium or steel) for each subtrate material a new coatmas-
ter application should be created. 

The reference samples should be kept, if possible, to check the long-term stability of the coatmaster. 
  
To make a new application, produce the reference samples and keep them at hand for the calibration 
process. Switch on the coatmaster and start the coatmaster 3D Operating System. In the Application 
area on the left-hand side click the button add App (see Area 2 in Figure 16). If this Area is not pre-
sent, the administrator has locked this feature for the user. To unlock this feature, please enter the 
administrator password (refer to chapter 4.4.3). 
 
Follow the application setup procedure as follows. 

5.5.1. Setup application 

In order to be able to measure on a certain sample, you’ll need to create an application for the spe-
cific coating and substrate material. This section describes the process to do so. 
  

1. Once the lamps and the head are adjusted, you can start a calibration by pressing the add 
App button (see Figure 24) in the main window (as in chapter 5.6.2 for the lamp adjustment). 

2. In the calibration window, select the level image (see Figure 26)  tab and adjust the sliding 
button to set a minimum temperature level as previously described. 

3. You now need to add reference points: on the image, position the mouse pointer on a point 
whose coating thickness is already known and right-click with your mouse.  

4. A subwindow will appear where you can enter the thickness of the coating of this particular 
point and label the point accordingly (see Figure 17) 
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Figure 18 defining a reference measurement 
 

5. Have at least 2 reference points to make a proper calibration whole list appears in the left 
bottom part of the window (see Figure 18). In this list, you can remove reference points by 
pressing the Remove button in the reference list. A subwindow will pop up to ask for a confir-
mation (see Figure 19)  

 
Figure 19 Removing calibration points 1 
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Figure 20 Removing calibration point 2 

 
 

6. Select the Data View tab to display the temperature decay curves of the reference points 
(see Figure 20). 

7. Adjust the measurement duration with the sliding button as described in chapter 5.3.2, so 
that it corresponds a value which corresponds to the end of the decay curves (in this case 
around 0.5 s). Selecting a too long measuring time may affect the measurement precision. 

8. Save the calibration. The application appears in the application list. 

 
Figure 21 Optimising the measuring time 
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5.6. Measuring with coatmaster Operating System 

Make sure the coatmaster and the operating computer are connected with an Ethernet cable. The IP 
address of the coatmaster is noted in the coatmaster Service Book, which is part of the scope of de-
livery. 
coatmaster GUI (cm3dGui_v2_013) must be installed on a Windows computer for making applica-
tions and running manual measurements. Turn the coatmaster on and after one minute connect the 
computer with the coatmaster by ethernet: 
 
Ethernet: Connect the computer and the coatmaster with Ethernet. This is possible either by direct 
connection with one cable or by integrating the coatmaster in your local network. 
 

• Copy the bcm3dGui_v2_013 (or the latest version) file to the laptop, unzip it and launch the 
GUI cm3dguiQml.exe file in the release subfolder. 

• Switch on the cm3D rack (front button) and the ventilation, if present (wait one minut in or-
der to let startup all the components of the coatmaster). 

• On the main window of the GUI select File and then Device (see Figure 5). 
• In the dialog window select the coatmaster to connect to (see Figure 6). 
• In case the coatmaster does not appear in the list select the add new device button and enter 

the IP address of the coatmaster 3D (here:  192.168.10.155) 
 Please pay attention that the laptop-client and the cm3D must be in the same subnet 
 

After connecting with the coatmaster, start the coatmaster 3D Operating System. The main window 
opens (see Figure 17).  
 

 
 
Figure 22 The main window of the coatmaster 3D Operating System is divided into four areas: 1. Menu, 2. Applications, 3. 
Measure and 4. Previous measurements 

2 

1 
4 

3 
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1. Menu 
2. The left part is dedicated to the applications management 
3. The central part is dedicated to the results management with three different tabs 

a. The ir live view tab which displays the live image in the infrared spectrum by the opti-
cal head 

b.  The rgb live view tab which displays the live image in full color by the optical head 
(optional, not always available) 

c. The result View tab where the results can be displayed, partly analysed and the data 
cab be managed 

4. The right part is dedicated to the management of the measurement data.   
 
 
Note: 
To carry out measurements first select the application from the Application area (2). If there is no ap-
propriate application available, you can create one as described in chapter 5.7.  
 

5.6.1. Adjusting the position of the coatmaster 3D head 

1. On the coatmaster 3D User Interface, select the Ir live View tab (see Figure 22) 
2. If your coatmaster 3D is well set up, you should see a live image of the IR camera 
3. Adjust the camera focus by tourning the objective ring to get a sharp image on the screen. 
4. Position the optical head with respect to the pieces you want to measure. 
5. You have the possibility to display the image at different angular orientations by selecting 

the Options and Camera Orientation tabs (see Figure 18). 
 

 
Figure 23 Tab for ir live view 
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Figure 24 Camera rotation option 
 

5.6.2. Adjusting the position of the coatmaster 3D lamps 

1. Preposition the lamps so that they illuminate symmetrically the samples to be measured 
2. Make sure that the lamps are not covering in the field of view the camera (tab IR live View) 
3. At the bottom left corner of the main window, press the add APP button (see Figure 24). A 

subwindow appears where you must enter the application name and select a certain energy 
(see Figure 25). You can start with flash energy 1 and if it’s not enough, it’s possible to adapt 
it afterwards. When you press OK a confirmation window will appear to confirm that you 
want to trigger a flash (see Figure 25). Confirm by pressing the OK button. 

 
Figure 25 Enable the flash to adjust the lamps 
 

 
Figure 26 flashing to adjust the lamps 
 
 

4. A calibration window will open (see Figure 26). 
5. Select the level image tab (see Figure 26) 



coatmaster 3D user manual   

 

 
38/63  

6. Adjust the threshold sliding button (see Figure 26) and check that all parts of the object you 
want to measure sees an increase of its temperature of 0.4°C. Set the threshold value, so 
that the temperature increase of  background scene does not interfere too much with your 
object (see Figure 27). The higher the increase in temperature, the better the precision. The 
uniformity of the temperature over the overall field of view is not a requirement to get good 
results.                              

 
Figure 27 lamp adjustment by visualising minimum temperature changes after flashing 1 
 

 
Figure 28 lamp adjustment by visualising minimum temperature changes after flashing 2 
 

7. If the temperature increase is not high enough, after having pressed the close button in the 
calibration window, you can: 

a. Increase the energy of the lamp flash by increasing the level (see Figure 25). 
b.  Bring the lamps closer to the objects, maybe at the price of a reduction of the field 

of view. 
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8. Reiterate the operation 1 to 7 until you get a satisfactory result.  
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5.6.3. Management of the applications 

The left part of the User Interface is dedicated to the management of calibrations (see Figure 18).  
 
1. Make a new application by pressing the add App button as 
described in chapter 5.5. 
2. Edit an application by pressing the Edit button; this will allow 
you to visualise and modify the parameters of the application like 
e.g measuring time, reference points or name. 
3. Delete an application by pressing the Delete App button. 
If you delete an application all measurement data associated to 
this application will also be deleted from the server. Be sure to ex-
port the relevant measurement data locally before deleting an ap-
plication.  
4. Update the application list by pressing the reload button. This 
can be of particular interest if an application is made on one client, 
and the measurement is manually done on another one. 
5. Copy an application by right-clicking on the application (see 
Figure 31). All parameters of the applications will be copied in a new 
one except the application number. This can be of practical interest 
if you want to delete all measurements done with an application but 
want to keep the application. 
 
 

Figure 29 Management of the applications 
 

6. Export an application by right-cliking on the application (see Figure 28). A window will appear 
and you have to chose the location, where will be the application exported. All parameters of 
the applications will be copied in a new one except the application number. (See chapter 
5.7.1). 

7. The application which were saved but are not completed (missing for instance reference 
points) appear in grey. They can be edited or removed but cannot be used to perform meas-
urements. 
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5.6.4. Manual measurement 

Once you have done a calibration, you can use it for a measurement. The calibration you did will ap-
pear in the calibration list and you select it by clicking on it (see Figure 29). 
Press the Measure button to do a thickness measurement. 

 
Figure 30 Measurement 
 

5.6.5. Visualising results with the coatmaster 3D 

The measurement you did after pressing Measure button will be displayed automatically in the result 
View tab (see Figure 30). The thickness mapping is displayed in false color and by pointing the mouse 
on any measurement point, you can display the measured thickness value (here 79 microns). 
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Figure 31 Measurement result 
 
You can zoom-in or out the results by positioning the mouse on the map and scrolling your mouse. 
You can displace the map by maintening the left-click on the mouse and displacing the map. 
You have 2 ways to change the color scale and for which the displayed results will be automatically 
adjusted: 

a. Automatically: you first need to select the Autoscale option (see Figure 33). By pointing the 
mouse onto the scale and scrolling, you can change the scale range. The minimum value can 
be adjusted by pointing the scale and moving the mouse while left-clicking. 

b. Manually: if you de-select the auto-scale option, the minimum and maximum values of the 
scale can be manually entered. The scale and the displayed results will be automatically ad-
justed (see Figure 32). 

 
      Figure 33 Manual scale adjustment 

Figure 32 Automatic scale adjustment 
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You have the possibilities to define freely Regions of Interest (ROI) to display geometrical statistical 
values (minimum, maximum, average and standard deviation of the measured values).  

a. Select the ROI button (see Figure 36) and click on the ADD ROI button.  
b. A window with the settings of the ROI will appear. Select the ROI shape, the name 

and confirm with OK.  
c. Right click on the thickness map and move the ponter to define the size of the ROI 
c. You can change the size of the ROI by pointing and left clicking the mouse on one of 

the corners and adjust the size accordingly. 
d. The position of the ROI can be freely adjusted by left clicking inside the ROI and dis-

placing the mouse pointer where you want to have the ROI positioned. 
e. By right-clicking inside the ROI you can delete an ROI (see Figure 37). 
f. If you select and unselect the ROI button the latest ROI design will be displayed. 

 

 
 

 

 
Figure 35 Deleting a ROI 
  
  

Figure 34 ROI 
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Selecting the 3D view option as showed in Figure 35 you can change the result view into 3D form. Po-
sitioning the mose on a certain point, the actual thickness value will be showed. To zoom-in and  
-out there is a slider on the right part of the window called scale factor. You can rotate the image by 
pressing the right mouse button and move the image.  

 
Figure 36 3D view 

 

5.6.6. System information 

To display information about the software version and the company address, press the Help > About 
in the Menu area.  

 
Figure 37. System information in the software 

  
Press OK to close this window. 
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5.7. Back-up and Transfer of coatmaster 3D applications 

Application data is stored in the coatmaster’s embedded PC. If this PC crashes or is destroyed the 
work to create the applications is lost. It is therefore strongly recommended to save applications by 
exporting this data from the coatmaster to an external storage. Furthermore, applications can also 
be transferred between different coatmaster systems.  

5.7.1. Export applications 

To export an application, right click on the application and Export application as in the follow picture. 

 
Figure 38 Export application 
 
 
You will have to choose the folder in which the application will be exported (see Figure 38). 
Once you click on choose folder, the application will be automatically exported.  
 

 
Figure 39. Export window, choose a folder  
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5.7.2. Import applications 

To import previously exported applications, select File > Import Application (see Figure 40). 
 

 
Figure 40. Window for importing an application in the stand-alone software 
 
In the dialog window, select the application from the folder where it was previously saved and click 
on import. The application file is now imported and added to the lists of applications. 
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5.8. Export measurement data 

You can select an ongoing automatic measurement export or export the measurement at once man-
ually. Both modes are described in the next chapters.  
 

5.8.1. Exporting data manually 

Clicking on File -> Export a window for the export will open (see Figure 40). 

 
Figure 41. Exporting measurement data in the stand-alone software 
 
First you have to select the application of which measurements you want to export. Then you choose 
the period from-to you want to export. The measurements will be showed in the lower side of the 
window. Clicking on Export measurements a window will appear where you have to choose the 
folder, where the measurements will be saved. When you click Ok the measures will be exported.  
The measurements are exported in a CM3DBIN file format, which can be read only by a coatmaster 
3D software. 
If you prefere to analyse the exported measurements on an Excel table, you have to select export as 
csv. 
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5.8.2. Exporting data automatically 

Opening Options -> Settings you can enter into the settings for the automatic measurements export 
(see Figure 41). 
 

 
Figure 42 Automatic export settings 
 
Select save measuremetns locally and select the path (folder, where the measurements will be 
saved). As mentioned in the preview chapter Exporting data manually, is possible to export the data 
as CSV file format so they can be analysed in Excel.  
 
It is possible to export statistics and measurements as well with a PLC. See chapter XX for more infor-
mation about the remote control.  
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6.  Remote control 

This chapter describes the operation of the coatmaster using any device that establishes a TCP con-
nection to the Coatmaster via Ethernet. This can be for example a PLC (e.g. Siemens S7, see chapter 
6.2) or a computer running software from a third party. The coatmaster Operating System software is 
using remote protocol to control the coatmaster. 
 
The coatmaster is operated by commands that are sent from the device to the coatmaster. The result 
of the command is sent back from the coatmaster to the device. The coatmaster acts as a server for 
remote control operation. The device acts as a client.  
 
It is possible to use a TCP/IP based interface to remotely control of the coatmaster.  
 
To use the TCP/IP interface, proceed as follows: 
 

Commands and results for the TCP/IP interface are listed in chapter 6.1. 
 

6.1. TCP/IP  

The commands and the results are transferred as ASCII text lines. After a command is processed, the 
TCP/IP connection is disconnected by the coatmaster server, to allow access by other clients. The 
connection has to be re-established for the next command 1. 
 
The port is 1234. 
 

6.1.1. General format of commands and results 

A command line string has the following format:  
<COMMAND>?<ARGUMENT1>=<VALUE1>&<ARGUMENT2>=<VALUE2>&…. \r\n 
 
The elements in a command line have the following meaning: 

„COMMAND“: Command name 
„?“: Separates a command from the arguments 
„ARGUMENTx“: Name of a command argument 
“VALUEx”: Value for the command argument 
„=“: Separator sign between command argument and value  
„&“: Separator sign between command arguments 
<...>: Place holder for dynamic values 

 
1 It is possible upon request to keep the connection open. Please contact coatmaster AG if you have such a 
need. 
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„CR/LF“: ends the command (line break (Hex 0D 0A, escape sequence \r\n) depending on 
the PLC in use)  
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The coatmaster responds to commands with results with similar formats: 
 
RESULT?ARG1=VAL1&ARG2=VAL2&...\r\n 
where 
 

„RESULT“: Result name 
„?“: Separates a command from the arguments 
„ARGx“: Name of a command argument 
“VALx”: Value for the command argument 
„=“: Separator sign between command argument and value  
„&“: Separator sign between command arguments 
<...>: Place holder for dynamic values 
„CR/LF“: ends the command (line break (Hex 0D 0A, escape sequence \r\n) depending on 
the PLC in use) 

 
The argument STATUS is contained in every command result and assumes the following values: 

• OK: The command was carried out correctly. 
• ERROR: The command was not carried out correctly. 
• WARNING: Warning, e.g. when the measuring values are not reliable 
• MESSAGE=<VAL>: Description of the problem in case of an error or warning message 
 

6.1.2. MEASURE command 

Use the MEASURE command to trigger a coatmaster measurement. You have to select a coatmaster 
application for the measurement. This is specified by an ID which is the only argument for the MEAS-
URE command. 
 

• MEASURE? 
• Description 

o Performs a measurement for the selected application 
• Arguments 

o CONFIG_ID=<id>  (application ID) 
o ORDER_NR=<string> (adds an order Nr. To the measurement, this argument is optional) 

• Answer 
o RES_MEASURE?STATUS=BUSY 
o RES_MEASURE?STATUS=ERROR&MESSAGE=<error message> 
o RES_MEASURE?STATUS=OK&CONFIG_ID=<application id>&MEASURE_ID=<measurement 

id>& TIMESTAMP=<timestamp> 
o If there are ROIs defined for this application the Statistics for all rois will be appended 

 &[NAME,VALID,MIN,MAX,AVG,DEV]=[<ROI name>,<true/false>,<MIN Thick-
ness>,>,<MAX Thickness>,>,<average>,<deviation>],[...],[...] 
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• Example command 

o MEASURE?CONFIG_ID=1&ORDER_NR=Batch1\r\n 
• Example answer 

o RES_MEASURE?STATUS=OK&CONFIG_ID=1&MEASURE_ID=2548& 
TIMESTAMP=125478954& 
[NAME,VALID,MIN,MAX,AVG,DEV]=[RIO34,true,1,23,12,1.2]\r\n 

 

6.1.3. GETCONFIGURATION command 

Use the GETCONFIGURATION command to retrieve the name and the Id of an application stored on 
the coatmaster.  
 

• GETCONFIGURATION 
• Description 

o Returns the id and name of an application 
• Arguments 

o CONFIG_ID=<id> (application ID) 
• Answer 

o RES_GETCONFIGURATION?STATUS=ERROR 
o RES_GETCONFIGURATION?STATUS=OK&ID=<id>&NAME=<name> 

• Example command 
o GETCONFIGURATION?CONFIG_ID=1\r\n 

• Example answer 
o RES_GETCONFIGURATION?STATUS=OK&ID=1&NAME=newApplication\r\n 

 

6.1.4. GETCONFIGURATIONS command 

Use the GETCONFIGURATIONS command to retrieve a list of all applications stored on the coatmas-
ter. This command has no arguments. 
 

• GETCONFIGURATIONS 
• Description 

o Return a list with all valid application ids and names 
• Arguments 

o - 
• Answer 

o RES_ GETCONFIGURATIONS?STA-
TUS=OK&ID=<id1>&NAME=<name1>&ID=<id2>&NAME=<name2> … 

• Example command 
o GETCONFIGURATIONS\r\n 

• Example answer 
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o RES_ GETCONFIGURATIONS?STATUS=OK&ID=1&NAME=test&ID=5&NAME=newAppli-
cation\r\n 

 
 

6.1.5. GETCONFIGIDS command 

Use the GETCONFIGIDS command to retrieve a list of the IDS of all applications stored on the coat-
master. This command has no arguments. 
 

• GETCONFIGIDS 
• Description 

o Return a list with all valid application ids 
• Arguments 

o - 
• Answer 

o RES_GETCONFIGIDS?STATUS=OK&ID=<id1>&ID=<id2>…... 
• Example command 

o GETCONFIGIDS\r\n 
• Example answer 

o RES_GETCONFIGIDS?STATUS=OK&ID=1&ID=5&ID=7\r\n 

 

6.1.6. GETCOATMASTERSTATUS 

Use this command to get general information on the coatmaster. This command has no arguments. 
 

• GETCOATMASTERSTATUS 
• Description 

o Returns the current status of the coatmaster 
o READY=1 -> ready to flash (min wait time reached & flash generator ready & safety 

switch ) 
o GENERATOR_READY=1-> the safety switch is closed ready to flash 
o SAFETY_SWITCH=1 -> the safety switch is closed ready to flash 
o FUS_AVAILABLE=1byte hex (available flashunits each bit is one unit) 

 Example FUS_AVAILABLE=0h1d= 0b11101 -> flashunits 0,1,2 and 4 are con-
nected 

o FUS_READY=1byte hex ( ready flash units) 
 Example FUS_READY=0h05= 0b0101 -> flashunits 1 and 3 are ready 

• Arguments 
o - 

• Answer 
o RES_GETCOATMASTERSTATUS?STATUS=ERROR 
o RES_GETCOATMASTERSTATUS?STATUS=OK&READY=<0 /1>&GENERATOR_READY=<0 

/1> &SAFETY_SWITCH=<0/1>&FUS_AVAILABLE=<0h1f>&FUS_READY=<0h1f> 
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• Example command 
o GETCOATMASTERSTATUS \r\n 

• Example answer 
o RES_GETCOATMASTERSTATUS?STATUS=OK&READY=1&GENERATOR_READY=1 

&SAFETY_SWITCH=1&FUS_AVAILABLE=1f&FUS_READY=1f\r\n 

 

6.1.7. GET_FLASH_ENERGY command 

Use the GET_FLASH_ENERGY command to request the current energy set of the generators This com-
mand has no arguments. 
 

• GET_FLASH_ENERGY 
• Description 

o Returns the current set flash energy of the generator 
o <energy> is the energy level integer number from 1-7 

• Arguments 
o - 

• Answer 
o GET_FLASH_ENERGY?energy=<energy> 

• Example command 
o GET_FLASH_ENERGY\r\n 

• Example answer 
o GET_FLASH_ENERGY?energy=6\r\n 

 

6.1.8. SET_FLASH_ENERGY command 

Use the SET_FLASH_ENERGY command to set the flash energy to a specified energy level (1-7) either 
by providing the energy level directly or by choosing an application id (it will set the energy level to the 
predefiened enery level of this application). This command has no argument. 
 

• SET_FLASH_ENERGY 
• Description 

o Sets the flash energy to a specified energy level (1-7) either by providing the energy level 
directly or by choosing an application id (it will set the energy level to the predefiened 
enery level of this application) 

• Arguments 
• Only one of these Arguments should be provided 

o energy=<level> (integer number 1-7) 
o ID=<id> (application ID) 

• Example command 
o SET_FLASH_ENERGY?ID=5 \r\n 
o SET_FLASH_ENERGY?energy=6 \r\n 

• Example answer 
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o SET_FLASH_ENERGY\r\n 

 

6.2. Siemens S7 

 
Important note for users of a Siemens SIMATIC S7 PLC: 
The Siemens S7 PLC is available in two different product types, which react differently with an Ether-
net connection – Type PN/DP and Type DP.  
 
Type PN/DP: This type has Ethernet integrated in the CPU. The opening and closing of the Ethernet 
connection is done automatically and requires no special commands in the software.  
 
Tyep DP: This type does not have Ethernet integrated in the CPU. For this type, the Ethernet connec-
tion must be opened before each command and closed after each command by software.  
 
Example code available at http://www.coatmaster.com/integratoren 
 
 
 

http://www.coatmaster.com/integratoren
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7. Maintenance / Service 

Maintenance / Service can only be conducted by authorized personnel! Unauthorized personnel risk 
personal injury and damage to the coatmaster! 
 
Use only coatmaster AG consumables and spare parts for maintenance and repair to assure system 
performance and reliability. Any modifications to the spare parts are only allowed with the prior writ-
ten permission of coatmaster AG. 

7.1. General 

 

 

 
WARNING 

Risk of burns by electric current. Serious injuries or death can result. 

Prior to any maintenance and service, switch off the device and unplug the mains cable. Mainte-
nance work may be conducted by authorized personnel only! 

 

 
Do not open the housing of the coatmaster, even when the coatmaster is not connected to the 
mains. Opening the coatmaster will void any liability and annuls the guarantee.  
 
The maintenance must be done by a coatmaster technician or by a trained service engineer.  

7.2. Lamps 

The degradation of the lamps is depending on the frequency of the measurements and on the flash 
energy used. If the lamps are not changed, it can lead to a decrease of the flash energy and a de-
crease of the measurements accuracy. Deal with coatmaster AG the service interval needed, depend-
ing on your measuring frequency and the flash energy used.  

7.3. Lamp glass 

Due too the degradation of the covering plexiglass on the lamps, those must be replaced when the 
lamps are replaced. If the degradation is too strong before the service, please contact coatmaster 
AG. High degradation of the front glass can decrease the flash energy.  

7.4. Measurement cameras 

Clean the measurement cameras from any contamination by oil-free compressed air to assure good 
coatmaster performance and reliability. 
Stubborn contamination can be removed with the soft, lint-free cloth and alcohol (e.g. eyeglass 
cleaning cloth). 



coatmaster 3D user manual 

  57/63 

7.5. Climatized electrical cabinet air filter 

On the air conditioning system of the electrical cabinet (if present) there is a filter pad which need to 
be inspected regularly. When is contaminated, it needs cleaning. For very strong contamination an 
exchange is necessary. 
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8. Troubleshooting 

If a software error occurs, restart the device. If the error persists, contact your administrator and pass 
the error code.  

 

In case of hardware defect or malfunction  proceed as follows: 
1. Disconnect the device from the control unit immediately. 
2. Inform the responsible person at the operating location about the fault. 
3. Repairs may be conducted by authorized personnel only! 
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9. Technical data 

9.1. Data sheet coatmaster 3D 

 
 

 

 
 

coatmaster 3D 
 

Energy 750 J – 3000 J 
Measurement distance 10 cm – 120 cm 2 
Measurement area fully scalable 
Measurement range: 1-2000 µm  
Measurement duration 0.5s 

Repetition rate 

2,9 s at 750 J 
4,3 s at 1125 J 
5,8 s at 1500 J 
7,2 s at 1875 J 
8,6 s at 2250 J 
10 s at 2625 J 

11,5 s at 3000 J 

Relative standard deviation < 2% 5 

Pixels per measurement 382 x 288 
Tilt tolerance ±70˚ 4 
Functions on all colors (includ-
ing white) 

Yes 

Automated data export Yes 
Power connection IEC 320-C14 
Supply voltage 230 V AC, 50 Hz 
Fuse 16 A for each phase 
Power consumption max. 2000 W 
Operating temperature 5°C – 35°C 
Relative humidity < 80 % 
Dimensions (mm) 374 x 490 x 196  
Weight 16.8 kg 
Interface: 

Ethernet  
External trigger 

 
Yes 

Optional 
 
 
 
 

 
2 depending on coating, substrate and chosen energy level 
5 60 µm powder coating before curing (all colors incl. white) on aluminium, 5 cm working distance 
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10. Transport, packaging, storage 

10.1. Transport inspection 

The delivery must be checked for completeness and possible transit damage immediately at receipt.  
In case of externally visible damage, proceed as follows: 

• Do not accept the delivery or only under reserve.  
• Note extent of damages on the transportation documents or on the delivery note of the car-

rier.  
• File complaint. 

Claim any damage as soon as it is detected. Compensation claims can only be submitted within the 
applicable complaints’ periods. 

10.2. Packaging 

Dispose of packaging material in accordance with the respective valid laws and local regulations. En-
vironmental damage caused by incorrect waste disposal! Packing materials are valuable raw materi-
als and can continue to be used in many cases or sensibly reconditioned and recycled. 

• Dispose packaging material environmentally friendly. 
• Adhere to the valid local regulations for disposal. If necessary, employ a special waste dis-

posal company to dispose of packing material. 

10.3. Storage 

Possibly, there are instructions on the packaging for storage that exceed the requirements men-
tioned here. These must be adhered to. 

Store packages under the following conditions: 
• Do not store outdoors 
• Store in a dry and dust-free environment 
• Do not expose to aggressive media 
• Protect against solar radiation 
• Avoid mechanical shocks and vibrations 
• Storage temperature: 15 to 35 °C 
• Relative humidity: max. 60 % 

 
For storage exceeding 3 months: 
• Check the general condition of all parts and the packing regularly 
• As necessary, renew or replace the conservation 
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Appendices 
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11. Appendix A: tests with flame detector 

11.1. STS flame detector  

 
 
___________________________________________________ 
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11.2. Total Walther UV-03 flame detector  
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